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Agenda

iz

10:00 - 10:15 Opening of 51D and welcome
10:15 - 10:30 About the IPNew Project
Introduction of the system
10:30 - 10:40 Log-in, Registration of users, Assignment of rights
10:40 -11:00 Capacity booking
11:00 -11:20 Anonim market, bilateral transaction
11:20 -11:35 Break
11:35 -12:00 Momination, Trade
12:00 -12:20 Operation of the Trading Platform (unchanged)
12:20 -12:40 New functionalities
- Phase-out and change of backhaul
- Introduction of over-nomination
12:40 - 13:00 Break
13:00 - 13:30 Information on UAT

- Purpose of UAT concerning network users and
transmission system operators

- Interface calls, technical information, schedule
- Q&A



IPNew Project

www.fgsz.hu

About IPNew Project

lecturer: Csanalosi Tamas



IPNew Project

—
 Motivation

— Efficient implementation of legislative and user
requirements based on modern IT basis

* Main milestones
— 2015: Project launch

— 2016: Logical system design
— 2018:

* Information to the partners

* Closing of the development, building infrastructure
* Internal and external testing (incl. UAT)

« Go live



IPNew Project

www.fgsz.hu

Further milestones
« 9 July Open up to partners

« 31 August Processing feedbacks,
configuration, bug fixing

« 24 Sep - 1 Oct® System functions go live



IPNew Project
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IPNew Project

Systems

RBP
P
KP

RBP.eu

« TSOdata
* |Pdata

www.fgsz

.hu



System demo

* Framework
— User experience
— Pages can be customized
— Export of listings into popular formats

— System messages appearing on screen and further
email notifications



System demo

Q&A...

Next topic:
Signing up / Registration
lecturer: Timea Jambor




Signing up / Registration
Signing up / Registration

on the new |IP, KP, RBP platforms

lecturer: Timea Jambor



Signing up / Registration

www.fgsz.hu

WHAT’S GOT BETTER?

= MORE SIMPLE AND UNIFIED

IDENTIFICATION WITH THE PUBLIC KEY ONLY ACROSS ALL
PLATFORMS

= MORE FLEXIBLE

ACCOUNT MANAGEMENT ON ALL PLATFORMS

SIGN UP FOR E-MAIL NOTIFICATION OR UNSUBSCRIBE FROM IT AT
ANY TIME
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Signing up / Registration

Existing Partner

1. NETWORK USER:
MAILING THE COSTUMER

CERTIFICATE (FOR UAT SUPPORT:
ONLY) TO REGISTERING THE

IN CERTIFICATE
,» ¥.CER” FORMAT

1. NETWORK

USER: SIGNING UP
& TESTING
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Signing up / Registration

New Partner |.

YOU FIND ALL THE
NECESSARY
INFORMATION AT:

REGISTRATION PROCESS:

LEGAL, FINANCIAL,
TECHNICAL & OTHER
NETWORKING
REQUIREMENTS

13



Signing up / Registration
New Partner lII.

News and Events UMM  Secure Area  Capacily Auctions  Buy-back auctions Members and IPs  Useful Information

Login
Register

MNews and Events UMM  Secure Area Capacity Auctions Buy-back auctions Members and IPs  Useful Information

User Registration Form

Full name:*

Email address:™
Password:™
Confirm password:*

Phone number.™

CAPTCHA

This guestion is for testing whether or not you are a human visitor and to prevent automated spam submission.
How muchis 3 + 5+ 47

14



Signing up / Registration

v fgszhu B
New Partner lll.

News and Events UMM  Secure Area  Capacity Auctions  Buy-back auctions E

Sikeres bejelentkezes!

On bejentkezett az rbp.eu weboldalra.

Itt igényelhet EIC kodot az FGSZ Zrt.-t6l.

Csak magyarorszagi jogi személyek igényelhetnek EIC kodot az FGSZ Zrt.-t8l. A nem-magyarorszagi jogi szemeélyek keressék fel a honos szabalyozasi
hivatalukat, vagy az ENTSOG-ot

[tt tud csatlakozasi igenyt benyujtani az Informatikai Platformra.

IP- regisztracié akkor szukséges, ha az FGSZ Zr. altal Uzemeltetett rendszeren tervez barmilyen jellegl tranzakciot, vagy az FGSZ KP Kft. altal Uzemeltetett
kereskedési platformhoz kivan csatlakozni. Ehhez az RBP-hez is regisztralni kell. (Info:kap@fgsz.hu)

Es itt tud csatlakozasi igényt benyujtani a Regional Booking Platform-ra.

RBP- regisztracio valamennyi, az RBP-hez csatlakozott TSO rendszerén tervezett tranzakciohoz szikseges. (Info:rbp@fgsz.hu)
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Signing up / Registration

| wwwigszhu [
* New Partner IV

Informatic Platform Capacity booking Platform [ 4:1:]

Uploading the *.cer certificate
Company information is
needed (EIC code, contracting
database, personal contacts)
Contracts to prepare
(framework contract for
capacity booking, IP network
usage contract, title transfer

Uploading the*.cer cerificate
Company information is
needed (EIC code, contracting
database, personal contacts)

TSO-s (select companies
registered on RBP)
Obligations & Rights

contract, balancing contract)
The following documents are
to be submitted (company
extract, specimen signature,
profit & loss statement, license
/statement)

Obligations & Rights
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Signing up / Registration

Q&A...

Next topic:
Registration of users, Assignment of rights
lecturer: Péter Vigh

www.fgsz

.hu
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Users - Rights

www.fgsz

Registration of users, Assignment of rights

lecturer: Péter Vigh

.hu
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RBP registration request - UAT

1. NETWORK USER: 1. NETWORK USER:

PROVIDING CERTIFICATE CUSTOMER SUPPORT: TESTING THE
IN .CER FORMAT TO TR TR (R TR AVAILABILITY

RBP@FGSZ.HU REGISTER MORE USERS

19



Certificate requirements

Most of technical requirements for electric cerificates will not
change:

« Version: v3
 Signature algorithm: sha256RSA

Non-technical requirements:

+ Issued by an external trusted service provider company
authenticated for the issuance of electronic certificates.

« The trusted service provider issues the electronic certificate
after the examination of the person’s identity. The issued
electronic certificate must be suitable for identifying a user.

20



Register own users

2. NETWORK USER:

NEW USER REGISTRATION IN CUSTOMER SUPPORT: 2. NETWORK USER:

THE APP TESTING THE AVAILABILITY

INSTALLATION OF CERTIFICATE
PROVIDING CERTIFCATE IN

(REGISTER MORE USERS)
.CER FORMAT TO THE APP

21



Register own users in RBP APP
sz

« Users with administrator rights is able to register more users and
assignment user

« Master Data>Users>New User>New User (for organizatio

econdary Market 4. rbp.eu™

n)

HU
il 14:13:57 (UTC) 1187021113

£
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Assignment of user authorities

« We can assign user roles while the registration process and we
can modify them later

« Master Data>Users>Choose user>Modify>User authorities
setting

Edit user roles (%]

Workspace: 58X-AGROPCHIM-14 (58X-AGROPCHIM-14) -

Roles: Role name 4

Metwork User Administrator
Metwork User Bidder
Metwork User Eilat

Metwork User OSBB
Metwork User Surrender

23



Assignment of user authorities

Q&A...

Next topic:
Capacity booking, bilat, anonim markt
lecturer: Zsofia Prekaczka

www.fgsz

.hu
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Capacity booking, bilat, anonim markt

Capacity booking, bilat, anonim markt

lecturer: Zsofia Prekaczka
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Capacity booking

Auction list, auction view

Bidding during running auction on interface
Ascending clock algorithm = monthly auction
Uniform price algorithm - daily auction

Bid modification, withdrawal

Comfort bidding functions:
» Create,
- Copy,
« Modify,
* Cancel,

« Suspend/activate.

Adding UPTA and ACTA bids to comfort bid profiles

26



Bilat, anonim markt

Create bilat deal on interface
List of capacity market offers and deals, filter conditions

Create new deal:

« Creat new offer

« Create related offer

« Approval/Rejection by TSO

27



Bilat, anonim markt

Q&A...

Next topic:
Nomination, Trade
lecturer: Zsolt Kovacs

www.fgsz

.hu
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Nomination, Trade

Nomination, Trade
lecturer: Zsolt Kovacs

www.fgsz

.hu
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Nomination, Trade

« Portfolio list changed

* Information windows

* Hourly operation

* maintenance

« Single side nomination

* Version handle

 Nomination via web service and APP
« History function

* Re-Fresh function

30



Nomination, Trade

« Transaction message (TRADE)

« QOperation changing !!! Matching!!!!
« Get Trade via web service and APP.
 Information windows,

« Imbalance nominations

« Cycle documents from NNO and Shipper view
« Closing time meaning
 Interruption notice

« Nomination acceptance documents
« Nomination row history

« Document import/export

31



Nomination, Trade

Q&A...

Next topic:
Trading Platform
lecturer: Balazs Tatar

www.fgsz

.hu
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Trading Platform

Trading Platform
lecturer: Balazs Tatar

www.fgsz

.hu
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Trading Platform

= : = 1 Azure TESZT-2 (Node-1)
09:20:04 (CET) |EB Engtish ~ | @ oT 01016

A
Welcome page

|@ 1. Books l@ 2. Offers “@ 3. Trades “Q 4. Reports ~ 04/07/2018

2 5. Administration

X

Announcements @

£

https://ipnewtest2.northeurope.cloudapp.azure.com/Fgsz.Kp.Web/?locale=en#
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Order book

Title product Locational product
wd/da: wd/da:

~ Azure TESZT-2 (Node-1) Dométor Zsolt

04/07/2018 1
Bl English = [ @ 4 15 7021018 (FGSZ Zrt)

‘& 1. Books ‘@ 2. Offers |B- 3. Trades ‘[& 4.Reports v |EZ‘ 5. Administration 09:20'57 (CET)

BookTitle

HEGda listtitle - 2018.07.05. - [T0001] Missing translation!

MGPda listtitle - 2018.07.05. - [T0001] Missing translation!

OpeningTradePrice: MaxTradePrice: MinTradePrice: ClosingTradePrice: SumTradeQuantity: TradeUnit: OpeningTradePrice:  MaxTradePrice: MinTradePrice: ClosingTradePrice: SumTradeQuantity: TradeUnit
0.0000 0.0000 0.0000 0.0000 a 500 0.0000 0.0000 0.0000 0.0000 Q 500
RemainingQuantity LimitPriceBuy RemainingQuantity LimitPriceSell IPMNetworkPoi... Remaining... LimitPriceBuy IPNetworkPoi... Remaining... LimitPriceSell

HEGwd listtitle - 2018.07.04. - [T0001] Missing translation!

MGPwd listtitle - 2018.07.04. - [T0001] Missing transiation!

OpeningTradePrice: MaxTradePrice: MinTradePrice: ClosingTradePrice: SumTradeQuantity TradeUnit: OpeningTradePrice:  MaxTradePrice: MinTradePrice: ClosingTradePrice: SumTradeQuantity: TradeUnit
0.0000 0.0000 0.0000 0.0000 a 500 0.0000 0.0000 0.0000 0.0000 Q 500
GasPeri... RemainingQu... LimitPriceBuy GasPeri... RemainingQu... LimitPriceSell IPNetwork... Gas... Remaini... LimitPriceBuy IPNetwork... Gas... Remaini... LimitPriceSell
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Order input

CreateTitle / Vételi ajanlat (X

ExchangeProductld:*

GazidGszak (ora):

IPNetworkPointld:*
OfferQuantity.”
LimitPrice:
ExchangeOrderTypeld™

ExpirationPeriod:

Mennyiség (k\Whsh):

Szabad fedezet:

buy

MGP within day / 2018.07.04. v

7 & GasHourFrom 13 % GasHourTo

12:00 19:00
MGP (SINBPOOOOOON) -
2

| Piaciar

RTM .
07/04/2018 oy Envenyesse ) o

© (ora)

7 x2x500=7,000

Sziikséges fedezet (HUF):

1,000 x 3.0000 x 7 = 21,000

19 843 093.5

CreateTitle / Eladasi ajanlat

ExchangeProductid™

IPNetworkPointld:*
OfferQuantity.”
LimitPrice:
ExchangeOrderTypeld.”

ExpirationPeriod:

Mennyiség (kWh/h):

sell

HEG day ahead / 2018.07.05. -
Balatonfiizfd (KABFUZFO11GN) v
4

5  Piaciar
RTM -

Ervenyessé T

07/04/2018 H]
(6ra).*

24 x4 x 500 = 45,000
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Order book

I@ 1. Books |@ 2. Offers I@ 3. Trades “ﬁ 4.Reports

0410712018 .  Azure TESZT-2 (Node-1)
09:37:53 (CET) | Enlish * |9 4 15700 1016 ‘

ListTitleOwn

@ Ujvételi ajanlat @) Uj eladasi ajanlat

Id Busines...  EntityStateName | ExchangeProductCode GasPeri...  ExchangeProductEntity StateName LimitPrice OfferQuantity RemainingQ... ExchangeO... CreationTime {
328 [T0001]... [T0001] Missing... ~ HEGwd20180702 20 @ [70001] Missing translation! 3.0000 5 5 RIM 7/212018 1:52 PM
329 [T0001]... [T0001] Missing...  HEGwd20180702 19 @ [T0001] Missing translation! 3.0000 5 5 RIM 7/212018 1:52 PM
330 [T0001]... [T0001] Missing... ~ HEGwd20180702 18 @ [T0001] Missing translation 3.0000 5 5 RTM 7/212018 1:52 PM
33 [T0001]... [T0001] Missing... ~ HEGwd20180702 17 @ [T0001] Missing translation! 3.0000 5 5 RIM 7/212018 1:52 PM
332 [T0001]... [T0001] Missing...  HEGwd20180702 16 @ [T0001] Missing translation! 3.0000 5 5 RIM 71212018 1:62 PM
327 [T0001]... [TO001] Missing... ~ HEGda20180703 @ [T0001] Missing translation! 3.0000 2 2 RTM 7/212018 1:51 PM
322 [TODDA]... [TO001] Missing...  HEGwd20180702 22 @ [T0001] Missing translation! 2.0000 2 2 TET 7/2/2018 1:50 PM
323 [TODOA].... [TO001] Missing...  HEGwd20180702 2 @ [T0001] Missing translation! 2.0000 2 2 TET T/2/2018 1:50 PM
324 [TODOA]... [TO00M] Missing...  HEGwd20180702 20 @ [T0001] Missing translation! 2.0000 2 2 TET 71212018 1:50 PM
325 [TODOA]... [TO001] Missing...  HEGwd20180702 19 @ [T0001] Missing translation! 2.0000 2 2 TET 7122018 1:50 PM
326 [TODO1]... [TO001] Missing...  HEGwd20180702 18 @ [T0001] Missing translation! 2.0000 2 2 TET 7/2/2018 1:50 PM
318 [TODOA]... [TO001] Missing...  MGPwd20180702 18 @ [T0001] Missing translation! 3.0000 2 2 RTM 71212018 1:49 PM
319 [TODDA].... [TO001] Missing...  MGPwd20180702 17 @ [T0001] Missing translation! 3.0000 2 2 RTM 7/2/2018 1:49 PM
320 [TO001]... [T0001] Missing...  MGPwd20180702 16 @ [T0001] Missing translation! 3.0000 2 2 RTM 71212018 1:49 PM
3 [TODOA]... [TO00M] Missing...  MGPwd20180702 15 @ [T0001] Missing translation 3.0000 2 2 RTM 71212018 1:49 PM
317 [TODOA]... [TO001] Missing...  HEGwd20180702 17 @ [T0001] Missing translation! 3.0000 1 1 RIM 71212018 1:49 PM
309 [T0001]... [T0001] Missing... ~ HEGwd20180702 21 @ [T0001] Missing translation! 5.0000 5 5 RTM 71212018 1:48 PM
310 [T0001]... [T0001] Missing... ~ HEGwd20180702 20 @ [T0001] Missing translation! 5.0000 5 5 RTM 7/2/2018 1:48 PM
<
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Realised trades

4h

ExchangeProductC...

MGPda20180623
MGPda20180623
MGPwd20150614
MGPda20180615
MGPda20180615
MGPda20180612
MGPda20180227
MGPda20180227
MGPda20180227
MGPda20180227
MGPda20180227
MGPda20180223
MGPda20180223
MGPda20180223

Vétel/Eladds

Eladasi ajanlat
Veételi ajanlat
Eladasi ajanlat
Veételi ajanlat
Veételi ajanlat
Veételi ajanlat
Eladasi ajanlat
Eladasi ajanlat
Vételi ajanlat
Eladasi ajanlat
Eladasi ajanlat
Vételi ajanlat
Eladasi ajanlat

Eladasi ajanlat

TradePrice

40000
3.0000
6.0000
5.0000
40000
3.0000
55500
55500
44440
44440
3.3330
5.0000
4.0000
50000

TradeQuantity

TradeUnit

a»

500
500
500
500
500
500
500
500
500
500
500
500
500
500

CreationTime 4

6/22/2018 2:00 PM
6/22/2018 2:06 PM
6/14/2018 3:22 PM
6/14/2018 11:15 AM
6/14/2018 11:15 AM
6/11/2018 3:30 PM
2/26/2018 3:24 PM
2/26/2018 3:19 PM
2/26/2018 315 PM
2/26/2018 3:14 PM
21262018 314 PM
2/22/2018 5:21 PM
2/22/2018 5:20 PM
212212018 5:20 PM

04/07/2018
09:39:19 (CET)

GasPeriodName

2018.06.23.
2018.06.23.
2016.06.14-12CGH
2018.06.15.
2018.06.15.
2018.06.12.
2018.02.27.
2018.02.27.
2018.02.27.
2018.02.27.
2018.02.27.
2018.02.23.
2018.02.23.
2018.02.23.

\EE English ]g,

Azure TESZT-2 (Node-1)

1.18.702.1016

IPNetworkPointCode

SINBPOOODOON
SINBPOO0O0ON
SINBPOOODOON
SINBPOOO0OON
SINBPOO0OOON
SINBPOO0D0ON
SINBPOOODOON
SINBPOO0DOON
SINBPCO0DOON
SINBPOOOD0ON
SINBPOO0DOON
SINBPCO0DOON
SINBPOOOD0ON
SINBPOOODOON
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||__R_' 1. Books “‘@ 2. Offers ‘[ﬁ 3. Trades ‘[@ 4.Reports * gg:gyi?{%Eﬂ £E English » |U ﬁ:':;ogis::;z (Node-1} ‘ :
ListTitle

ExchangePr MGP within day v " Hidt
Code GasDayName Entity StateName TradeUnit OpeningTradePrice ClosingTradePrice MaxTradePrice MinTradePrice SumTradeQuantity MarginalSellPrice
MGPwd20180216 2018.02.16 @ [T0001] Miss... 500 0.0000 0.0000 0.0000 0.0000 0 0.00
MGPwd20180217 2018.02.17 @ [70001] Miss... 500 0.0000 0.0000 0.0000 0.0000 0 0.0
MGPwd20180218 2018.02.18 ® [T0001] Miss... 500 0.0000 0.0000 0.0000 0.0000 0 0.0C
MGPwd20180219 2018.02.19. @ [T0001] Miss... 500 0.0000 0.0000 0.0000 0.0000 0 0.0
MGPwd20180220 2018.02.20 @ [T0001] Miss... 500 0.0000 0.0000 0.0000 0.0000 0 0.0
MGPwd20180221 2018.02.21 @ [T0001] Miss... 500 0.0000 0.0000 0.0000 0.0000 0 0.00
MGPwd20180222 2018.02.22 @ [T0001] Miss... 500 0.0000 0.0000 0.0000 0.0000 0 0.0
MGPwd20180223 2018.02.23 L ] [TO001] Miss... 500 0.0000 0.0000 0.0000 0.0000 0 0.0C
MGPwd20180224 2018.02.24 @ [T0001] Miss... 500 0.0000 0.0000 0.0000 0.0000 0 0.0
MGPwd20180225 2018.02.25 @ [T0001] Miss... 500 0.0000 0.0000 0.0000 0.0000 0 0.0
MGPwd20180226 2018.02.26 [ ] [T0001] Miss... 500 4.4000 6.0000 6.0000 4.4000 66 420
MGPwd20180227 2018.02.27 @ [10001] Miss... 500 0.0000 0.0000 0.0000 0.0000 0 340
MGPwd20180223 2018.02.28 @ [T0001] Miss... 500 0.0000 0.0000 0.0000 0.0000 0 340
MGPwd20180301 2018.03.01 @ [T0001] Miss... 500 2.0000 2.0000 2.0000 2.0000 1,000 3.50
MGPwd20180302 2018.03.02 @ [10001] Miss... 500 0.0000 0.0000 0.0000 0.0000 0 200
MGPwd20180303 2018.03.03 @ [T0001] Miss... 500 0.0000 0.0000 0.0000 0.0000 0 0.0
MGPwd20180304 2018.03.04 @ [T0001] Miss... 500 0.0000 0.0000 0.0000 0.0000 0 0.0
MGPwd20180305 2018.03.05. @ [T0001] Miss... 500 0.0000 0.0000 0.0000 0.0000 0 0.0

rs
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Change: No change:

iz

« Capacity product moves to - Contract with the CCP

RBP
« Guarantee system
« WD / DA separation
« Contract with the FGSZ
« Lot: 1000 kWh Trading Platform Ltd.

« Daily imbalance settlement
moves to IP

40



Trading Platform

Q&A...

Next topic:
Renaming Backhaul, Overnomination
lecturer: Balazs Tatar

41



Renaming Backhaul, Overnomination

Renaming Backhaul,

Overnomination
lecturer: Balazs Tatar

42



Renaming Backhaul

iz

As from 1 July 2018, backhaul is not a standalone capacity quality type (like firm or
interruptible)

The term backhaul was deleted from the Price Application Decree

Backhaul capacity offer:
« Until 30 June 2018: Mosonmagyarovar, AUT>HUN direction, entry, backhaul
« From 1 July 2018: Mosonmagyarovar, HUN>AUT direction, exit, interruptible
— The backhaul tag will also disappear from the auctions
— Send your nomination here:
 Name: Mosonmagyarovar (HU>AT) virtualis
« EIC: 212000000000003C
 |P code: KAMOSONM1HBN
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Overnomination with Booked Capacity

#DEMO_SHP_220180629 v1 Ossz betaplalas(kWhinap): 0 Ossz vételezés(kWhinap) 0 Egyensiily(kWh/nap): | 0 aiﬁiiﬁ?h[fégf[z%fz'ggggﬁgz.]m)

(] Nominalds szerkesztés 7] Nominalas export [ Nomindlds import

050
Ar... | Tipus Halozati pont név Nominalhat... RH Partner Napi menny... 0.45

0.40

Ki  Kétoldali ~ Beregdarsc 800 (HU>U... 240000 DEMO_SHP_2 (DEMO_SHP_2_EIC) 0 0.35
0.30

025
020
0.15
0.10
005
0.00

| @ Nominalasok @ Kapacitas ‘

Megszakitashan érintett pontok Karbantartasban érintett pontok
Tranzakcios értesitések
Név Kaod EIC kod Halozati pont név Halozati pont kod Teljesith...

@ Uj Tranzakcios értesités [ Import B Exportélds 5% Bedllitasok
nem tortént A yitott portféliot érin ncs ka 6 TMK
A.. | Halézati pont Kereskedelmi part... | Beny... Allok... Allapot Tranzakci... Forras Modosito Modositas... | Megjeg|

em érkezett. Fellleten keresztiil 0

Egyoldali meghatalmazis

Halézati pont Halozati pont Passziv szallito FGSZ SSN...

A megnyitott portfélict A megnyitott portféliét érintéen nem érkezett r

The point that can be overnominated is marked with bold italics
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Overnomination without Booked Capacity
| wwwigszhu B

[ Export

Hiba 1

[INDDOE] (Beregdarde 800 (HU=UA) (21Z000000000270Q, Ki) ponton tilnominalds tortént 14 gazératdl, ezért osszesen oranként 15000 kWhih értékd automatikus kapacitast vasarias fog torténi a nap
végéig. Folytatja?

Oldal: 1 Ossz. 1 (' Oldalanként  25db  ~ Sorok: 1- 1| Ossz 1

Edit nominations / Add new nomination row

Overnomination results in within-day capacity booking. Do you wish to proceed?
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After Overnomination

A S Labs LA E A ek \ FPRTY A Rendszerhasznald: DEMO_SHP
DEMO S Ossz betaplalas(kWh/nap): 0 Ossz vétel kWhinap): | 15000 Egy ly(kWh/nap): | -15 000
#DE - HP20180629 v1 oz betapiEiast nep) sz velezesiiininag) grenstlyininap) Médesits: DEMO_SHP_USER (DEMO_SHP) [Nagy Roland] (2018.06.29 16:09:52)

[ Nomindlds szerkesziés B Nomindlds export (] Momindlds import

Ar... | Tipus Halézati pont név 1 Nominalhat... RH Partner Napi menny...

‘ ® Nominalasok @ Kapacitas ‘

Kezdb oldal Egyensiilyozasi portféliok = Egyensiilyozisi portfolié - DEMO_SHP [2018.1 Nyitott = Kapacitis sze FGSZ_RHSZ -xxxx2/WD/2018.06.29-14/00001 - Kapacitds szerzédés _

&) Export (2) Elettérténet
#FGSZ_RHSZ-xxxx2/WD/2018.06.29-14/00001 - Kapacitas szerzddés - Aktiv Létrehozé: DEMO_SHP_USER (DEMO_SHP) [Magy Roland] (2018 06 29 16:09°52)
Pariner. DEMO_SHP (DEMO_SHP) GazidGszak tipus: MNapon beldli gaziddszak GazidGszak: 2018.06.29-14 [dszak: 2018.06.29 - 2018.06.30
Keretszerzddés FGSZ_RHSZ-000 (2015.06.29) Szerzédés érvényessége. 2018.06.29 -

Kapacitas adatok Dij adatok Szamla csomag sorok SzerzGdés ve

Szolgaltatas mindség Halozati pont kod Halozati pont név 1 Halozati pont EIC kod | Kapacitas termék Kapcsoltsag Lekotés (kWh/h) Lekotés kezdete Lekotés vége Verzié + Referencia tipus Hivatkozas tipus
= :INT - Interruptible (Z05), Beregdaroc 800 (HU>UA) (HABEREGD1HHN)

INT - Interruptible (Z05)  HABEREGD1HHN Beregdarde 800 (HU 21Z000000000270Q WITHINDAY_INT Nem kapesolt 1500000 201806 29-14GH 201806 29-24GH 1 Tilnominalas DEMO_SHP2018062
Tételek: 1 Osszesen: 15 000,00

The overnominated network point appears in the balancing portfolio with a different colour

The capacity obtained via overnomination appears in the capacity contracts module
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After Overnomination

Q&A...

Thank you!

to be continue pm 1:00

www.fgsz

.hu
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